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 1فصل 

  
 ورود به دیوایس:1مرحله 

 وصل کنید. PC به شبکه یا مستقیما به CAT5 دیوایس را با کابل 

 دیوایس  IP ردن: به دست آو2مرحله 

 رابشنوید.  IPو  را شماره گیری نمایید ##گوشی تلفن را به یکی از پورت های تلفن دیوایس وصل کنید و سپس 

IP  . را در مرورگر اینترنتی تان وارد کنید 

  

  

 

  

 

 

 

   Admin و تایپ Admin وارد شوید و یا با انتخاب operator  و پسورد Role از قسمت  Operator  می توانید با انتخاب 

 در بخش پسوردوارد رابط کاربری دیوایس شوید.

در بالای  Feature index اگر با کانفیگ کردن از طریق رابط کاربری تحت وب  آشنایی کافی  ندارید می توانید با انتخاب گزینه

 صفحه به بخش های مورد نظر هدایت شوید.
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 تنظیمات شبکه: 

  

 .بروید Basic>Network به مسیر

  

 

 

  

 توضیح آیتم
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Static     برای انتساب یک IP استاتیک به صورت دستی 

DHCP برای گرفتن یک IP از DHCP 

PPOE  وقتی که دیوایس را مستقیما به مودم وصل کرد ه اید وباید username و پسوردتان را که از ISP   گرفته اید را در

 فیلدهای مربوطه وارد کنید.

  

  

Port Forwarding: 

  

،  که پشت روتر در شبکه خصوصی محلی ، نصب OM پورت فورواردینگ به هاست های خارجی اجازه می دهد به  به دیوایس

 شده، بتوانندکانکت شوند.

بین دیوایس و یک  SIPدر دیوایس و ترانک  SIPچنین ارتباطی  برای مدیریت دیوایس از راه دور، رجیستر کردن ترمینال 

 ه خارجی ،  لازم است.دستگا

 پورت فورواردینگ در روتر تنظیم شده و نمونه ای از تنظیم روتر در شکل زیر نشان داده شده.

  

 

 روتر ، استاتیک تعریف شده. WANآی پی پورت 
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 روتر را وارد کنید. WANبروید و آی پی پورت  Basic> Domain nameبه مسیر  

  

  

 

  

  

 را فعال کنید. STUNبروید و   Basic>Networkسپس به مسیر 

  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

  

  

  

STUN .یکی از سه حالت را انتخاب کنید 

STUN Server آی پی STUN Server  .را وارد کنید 

  

  

  

  

  

  

 2فصل
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Auto Attendant 
  

 ، دیوایس می تواند تماس های ورودی را به سمت اکستنشن ها بفرستد. Auto Attendantتوسط 

 بروید <Auto attendant   Basicبه مسیر Auto Attendant برای تنظیم

  

 :Auto Attendantپارامترهای 

Operator  از هم جدا کنید. ,شماره داخلی را برای اپراتور اضافه کنیدو شماره ها را با  0می توانید تا 

 نحوه توزیع تماس

(Call 

distribution) 

Sequentialن موجود )آزاد( در لیست اپراتورها وصل می ورودی به اولین اکستنش ، تماس: ترتیبی

 شود.شروع همیشه از اولین اکستنشن موجود در لیست می باشد.

Circular آزاد( بعد از آخرین اکستنشنی که پاسخگو بوده)موجود :چرخشی، تماس به اولین اکستنشن ،

 می شود. وصل

Simultaneouslyود در لیست اپراتورها ، وصل تمام اکستنشن های موج همزمان بهبه صورت  س: تما

 می شود و اولین اکستنشنی که گوشی را بردارد کانکت می شود.
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Call to an 

operator 

 می باشد. 5این شماره برای وصل شدن به اپراتور استفاده می شود.پیش فرض عدد 

Ring the phone ود، دیوایس برای تماس گیرنده بوق اشغال اگر تماس ورودی بعد از این مدت)زمان زنگ خوردن تلفن(، پاسخ داده نش

 می باشد. 0پخش می کند.زمان پیش فرض 

 

  

Greeting خوشامد گویی( )پیغام 

 دیوایس یک پیغام خوشامد گویی برای تماس های ورودی دارد. 

 پیغام های خوش آمد گویی پیش فرض برای ساعات اداری و ساعات غیر اداری در جدول زیر آورده شده است:

  

 را آماده کرد: Greeting طریق می توان  پیغام 8به 

 از طریق متن

 رکورد کردن پیغام خوشامد گویی از طریق تلفن متصل به دیوایس

 آپلود کردن فایل پیغام خوشامد گویی 

  

 

 از طریق متن 
د به اینترنت این روش بسیار ساده است و پیغام خوشامد گویی کیفیت صدای بالایی خواهد داشت.برای این روش بای

 را فعال کنید. DNS بروید و  Basic> Network متصل باشیم. بنابراین به
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 بروید و در بخش مربوطه متن خوشامدگویی را تایپ کنید و دکمه Basic>Text to voice greeting به قسمت

Start .را بفشارید 

   

 سپس فایل را ذخیره کنید.
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 بروید. Basic>Auto Attendant به قسمت

 خودتان را انتخاب نمایید. Greeting فایل Greeting و از قسمت
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 رکورد صدا از طریق تلفنی که به دیوایس متصل کرده ایم 
 * را شماره گیری نمایید و بعد از شنیدن صدای بوق پیغام خوشامد گویی را بگویید.سپس تلفن را قطع کنید.28

 ری نمایید.* را شماره گی2255برای شنیدن آن 

 * را شماره گیری نمایید و گوشی رابگذارید.2858برای ذخیره آن به جای فایل خوشامدگویی  

 * را شماره گیری نمایید و گوشی را بگذارید.2852برای ذخیره آن به جای پیغام ساعات غیراداری 

 * را شماره گیری نمایید.2258برای شنیدن پیغام  خوش آمد گویی ضبط شده 

 * را شماره گیری نمایید.2252یدن  پیغام ساعات غیراداری ضبط شده برای شن

 * را شماره گیری نمایید.2855برای ریکاوری جایگزینی پیغام ضبط شده 

  

 Upload کردن صدایی که از قبل آماده کرده ایم 
 بروید. System>Greetingبه 

 

 

 

 

 

 

 

 

 

 

 

 توجه:
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  G.729و برای فایل های با فرمت  UserXXX.pcmبه صورت  نام فایل باید G.711برای فایل های با فرمت 

 می تواند رشته ای از کاراکترها باشد. xxxباشد.که  userxxx.datنام فایل باید به صورت 

 می توانند برای تغییر فرمت فایل استفاده شوند. Cool Editنرم افزارهایی مانند 

 Basic>Auto Attendantجایگزین کردن فایل جدید به جای قبلی: 

  

 تکرار پیغام خوشامدگویی:

هنگامی که سیستم در حال پخش پیغام خوشامد گویی است و منتظر تماس گیرنده که شماره داخلی مورد نظر   

خود را بفشارد، پیغام خوشامد گویی می تواند چندین بار تکرار شود، به طور پیش فرض تا قبل از وصل شدن به 

 بار تکرار می شود. 8تماس گیرنده، این پیغام  اپراتور و یا شخص مورد نظر

 بروید. Basic>Auto Attendantبرای تغییر تعداد تکرار پیغام خوشامد گویی به مسیر 

  

 

  

  

  

  

 

 

 

 

 

 

  Basic > Auto Attendant برای ساعات اداری و غیر اداری می توان پیغام های خوشامد گویی مجزا قرار داد.در مسیر
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 نتساب پیغام خوشامد گویی به ترانکا

  

 بروید. Trunk> Analog Trunkمی توان به  هر ترانک یک پیغام خوشامد گویی  منتسب کرد، به مسیر  

 

  

  

  

 

 

 

 3فصل
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 اكستنشن ها

 مسیر تماس های خروجی: 

گیرد را می گیرد سپس شماره مقصد : کاربر یک شماره اضافی برای انتخاب ترانکی که می خواهد از طریق آن تماس ب Prefixبا  

 را می گیرد.

 بدون Prefix .کاربر شماره مقصد را بدون پیش فرض و مستقیما می گیرد : 
 بروید. Basic>Dialing ruleبرای تعیین مسیر تماس های خروجی به مسیر  

  

 Prefix .در این  قسمت ، یک پیش شماره  برای روت قرار دهید 

Route  ای متفاوتی  برای تماس های خروجی انتخاب کرد.می توان روت ه 

8. FXO : برای زنگ زدن  به خطوط PSTN از طریق   پورت FXO 

2.  IP  برای زنگ زدن به خطوط PSTN  از طریق SIP Trunk 

8. Route Table مسیر تعریف شده توسط جدول ای که برای زنگ زدن به خطوط PSTN می شود. استفاده 

Hunting     مدل 2ک ترانک آنالوگ داشته باشیم ، می توانیم مدل آزاد شدن خطوط را تعیین کنیم.که به اگر بیش از ی 

Circular و یا Sequential .می تواند باشد 

  

  

 به شماره داخلی دیگر بگیرید. بهتر است  * را قبل از زنگ زدن  را انتخاب کرده اید Prefixتوجه: هنگامی که حالت بدون 
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Hunt Group:  

( یک Prefixی از شماره های داخلی که برای تماس های به خصوصی سازماندهی شده اند.هنگامی که شماره پیشوند)گروه

Hunt Group  توسط کاربر گرفته می شود، تماس به داخلی های  موجود در آنHunt group  وصل می شود. مثلا کاربر، عدد

 بگیرد.  به برای گروه پشتیبانی را وصل شدن 2را برای وصل شدن به گروه فروش و شماره  8

  

 : Hunt Group تنظیمات

  

Prefix  .شماره پیشوند تماس با گروه را وارد کنید 

Hunting  مدل زنگ خوردن داخلی ها در Hunt Group  .را انتخاب کنید 

Extensions  اده و آنهارا با کاما از هم شماره های داخلی که می خواهید در این گروه قرار گیرند را  قرار د در این قسمت

 جدا کنید

  

  

 سطح دسترسی كاربران برای تماس : 
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هر کاربر  برای زنگ زدن سطح دسترسی دارد.اگر کاربری تماسی بالاتر از محدودیت خود داشته باشد، تماس او  توسط سیستم 

Reject .می شود و پیغامی هم برای او پخش می شود 

محدودیت های تماس  Call barringبروید و در قسمت  .Extensions> Analog extبه  برای تعیین محدودیت های تماس

 را اعمال کنید.

  

 

 ( :Group Call Pick Upجواب دادن به تماس به صورت گروهی)

 *  تلفنی که  در گروه خودشان زنگ می خورد را جواب دهند.05کاربران می توانند با گرفتن 

 Group nameبروید.و در قسمت  Extension  >Groupخاب کنید برای اینکار به مسیر ابتدا یک نام برای گروه انت .8

 نامی برای گروه انتخاب کنید.
  

 

  

  

  

  

 ها منتسب کنید. Extensionsگروه را به  .2
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 :فکس

 اگر شما دستگاه فاکسی دارید که می خواهید آن را به دیوایس نیوراک متصل کنید مراحل زیر را انجام دهید:

 دستگاه متصل کنیدو گوشی تلفن دستگاه فاکس را بردارید و شماره بگیرید.FXS دستگاه فاکس را به پورت  .8

 استفاده می شود. DIDاز   ))پیغام خوشامد گوییAuto Attendantبرای اجتناب از  .2

 بروید. Advanced>Mediaبه مسیر  IP Trunkاز طریق  FoIPبرای فعال کردن 

  

 

 Soft Attendant Console 
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 وضعیت داخلی ها و ترانک هار را می دهد و اپراتور ها می توانند فقط با یک کلیک روی کنسول  تماس را انتقال دهتد. 

Soft Attendant Console می تواندداخلی ها را به عنوان اپراتور منتسب کند ؟ 

 داخلی ها بروید. Roleبرای تععین   .Extensions> Analog extبه مسیر 

  

 :(External Party)خارجی شخص یک به تقال تماس ورودیان

  

 را انتخاب کنید. OTبروید. گزینه  .Extensions> Analog extبه مسیر

  

 خط استفاده می شود. 2در طی انتقال ، 

  

 

 :ها گزینه دیگر
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IP PBX  نیوراک قابلیت هایی مانندCall Forwarding ،Speed dialing  ،Caller ring back tone ،Call forking ،

Recording .و.. را برای داخلی ها فراهم می کند 

 بعضی از این قابلیت ها به طور پیش فرض فعال هستند ولی بعضی دیگر را باید فعال کنیم.

  

 

بروید و گزینه                         .IP ext. /Extensions> Analog extبه مسیر لیک کنید.را برای انتخاب سایر گزینه ها ک
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PIN number   نیوراک دسترسی  به کاربران اجازه می دهد که با یک تلفن خارجی به دیوایس*  99* و  88استفاده از

 داشته باشند.

Calling with 

PIN 

فعال شود.اگر کاربران بخواهند تماس های  Extensionبرای  PINاین گزینه را انتخاب کنید تا قابلیت 

 را قبل از شماره خود بگیرند. PINباشند باید  بیرونی داشته

Mobile به جای شماره PIN  برای تماس های 99* و 88شماره موبایل کاربر می تواند برای احراز هویت *

 بیرونی استفاده شود.

 Call 

Forwarding 

 برای انتقال تماس یکی از حالت های زیر را می توان انتخاب کرد:

 تماسغیر فعال کردن انتقال  .8

 انتقال کلیه تماس ها به تلفن دیگر .2

 انتقال تماس های بی پاسخ به تلفن دیگر .8

 انتقال کلیه تماس ها به صندوق صوتی .4

 انتقال تماس های بی پاسخ به صندوق صوتی .0
  

Forwarding 

Number 

شماره داخلی مقصد برای انتقال تماس را وارد کنید.بسته به حالت تماس های خروجی ممکن است یک 

Prefix  .برای شماره لازم باشد 

Forking  

Number 

ه یک تماس را به یک داخلی متصل کند و همزمان تماس را به یک داخلی اجازه می دهد ک IP PBX به

 دیگر هم متصل کند.برای فعال شدن این گزینه شماره تلفن را وارد کنید.

  

  

  

 

  

 : (Secretary Assistant)منشی 
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ند  به همراه داخلی مدیرش تنظیم شده باشد به صورتی که هنگامی که یک تماس به سمت مدیر می آید به سمت داخلی  منشی می توا

 منشی  هدایت می شود و سپس منشی آن را به داخلی مدیر انتقال دهد.

 : 8مرحله 

 قرار دادن یک شماره داخلی برای منشی 

 خلی منشی را در آنجا قرار دهید.به صفحه گزینه ای  شماره داخلی مدیر بروید و شماره دا

 

  

  

  

 :2مرحله  

 انتخاب حالت منشی دستیار 
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 منشی را فعال کنید. Pick upبروید و حالت   Basic>Auto Attendantبه 

  

 

  

  

  

  

 

 

 4فصل
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 ترانک
   

Trunk: 

Direct Inward Dialing (DID) 

  

تماس های ورودی  به آن  شماره تلفن  را به  IP PBXنک( منتسب شود و می تواند به یک شماره تلفن) ترا Extension) یک  داخلی) 

 داخلی متناظر با آن انتقال دهد.

 بروید. Trunk> Analog Trunk به مسیر

  

 :Caller ID تشخیص

 بروید. Trunk> Analog Trunk به  مسیرCaller ID برای فعال کردن    
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 .بروید  System>Trunkبه  Caller IDسپس برای تنظیم حالت  

  

 

  

 

 

  

  

 ITSP یک در IP Trunk كردن رجیستر
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 بروید. Trunk> IP Trunk Registration به مسیر

 بروید. Trunk> IP Trunkسپس به مسیر 

 

 بررسی وضعیت رجیستر شدن:

 بروید  Log>Resourceبه مسیر  

  

 

  

  

  

 5فصل 

 :سایت چندین بین تلفنی شبکه
  

 در یک یا چند سایت نصب می شوند می توانند با هداف زیر با هم در ارتباط داخلی باشند. دیوایس هایی که
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 افزایش سهولت .8

 تماس مستقیم و رایگان با یکدیگر و تماس به خطوط شهری بیرون از هر یک از ترانک های دیوایس ها .2
  

 سایت با یک طرح تماس ساده: چندین بین  تلفنی شبکه

ین چندین سایت، تماس های داخلی با گرفتن مستقیم شماره کاربر بدون شماره اضافی به عنوان در شبکه تلفنی ساده  ب 

 پیشوند، انجام می شود.

شماره گیری به این صورت ساده و مستقیم  است و بنابراین باعث افزایش ظرفیت پورت می شود و همچنین برای شرکت 

 ب هایی که دارای یک دفتر اصلی و چند شعبه دارند مناس

 است.

دقت کنید شماره های داخلی در شعب با هم یکی نباشند.تنظیمات شبکه تلفنی شامل تنظیمات دیوایس  سایت اصلی و 

دیوایس سایت اصلی نگهداری می شود و مدیریت از طریق  دیوایس های دفاتر توسط  تنظیمات دیوایس های شعب است. و لیست

 دیوایس سایت اصلی انجام می شود.

  

 :تنظیمات دیوایس سایت اصلی1مرحله 

  

 را انتخاب کنید. Simpleراانتخاب کنید و گزینه   Multi -Site تب
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 : فعال كردن یافتن اتوماتیک دیوایس2مرحله 

  

 دیوایس ها  :اضافه كردن سایت اصلی به لیست3مرحله 

 را برای اضافه کردن سایت اصلی)سایت مدیر( کلیک کنید. Addدکمه 

  

 

  

  

 

 

 

 

 

 

 

 

 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

 

 توضیح پارامترهای موجود:

  

IP Address IP Address  دقت کنید کهدیوایسوشماره پورت  ، IP Address باید سایت اصلی  دیوایس

 دربالای لیست ست شود.

Prefix  یعنی شماره های  2/8در این فیلد نحوه شماره های داخلی دیوایس را بنویسید.به طور مثال

 شروع می شوند. 2 رقمی هستند و با 8داخلی 

توجه: دقت کنید که طرح شماره های دیوایس ها در یک شبکه تلفنی باید به دقت بررسی شوند 

تا شماره ها در سایت ها با هم یکی نباشند.مثلا  رقم شروع شماره  ها در سایت ها نباید یکی 

به صورت   B و در سایت 2/8طرح شماره ها به صورت   A باشد.مثلا فرض می کنیم در سایت

 را بگیرد ) داخلی لوکال سایت 285، داخلی  A باشد.هنگامی که یک کاربر در سایت   28/8

A تماس به سمت دیوایس  سایت ،) B .روت)مسیردهی( می شود 

Whether to select a 

trunk for outbound 

calling on other 

devices 

ای  سایت ها اجازه داشته باشند برای تماس های انتخاب این گزینه  باعث می شود که از دیگردیوایس ه

 بیرونی از ترانک های این دیوایس استفاده کنند.

Area Code  .کد منطقه، تماس با منطقه ای که دارای کد است از طریق این ترانک روت می شود 

Phone Number    شماره ای که در این قسمت نوشته می شود،برای وقتی است که اگر کانکشن IP  قطع شد، از

 برقرار شود. PSTN طریق این شماره ارتباط با

Pilot number   شماره ای که در این فیلد نوشته می شو د، برای وقتی است که اگر ارتباطIP   قطع شد،تماس های داخلی

 برقرار شود. PSTNسایت ها از طریق 
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 :4مرحله 

 های سایت های دیگر سایر ، آنها را  به لیست اضافه کنید. و پر کردن اطلاعات  دیوایس   ADD با فشردن دکمه

  

 سایت با یک طرح تماس پیچیده: چندین بین  تلفنی شبکه

  

در تماس پیچیده برای جلوگیری از کانفلیکت شماره ها، رقم یا ارقام به خصوصی به ابتدا یا انتهای شماره مقصد اضافه می 

چندین سایت در مقیاس بزرگ  را با یک طرح تماس پیچیده برپا نمود و طرح شماره های شود.بنابراین می توان شبکه تلفنی بین 

 هر دیوایس )در هر سایت (می تواند  مستقلانه  مدیریت شود.

  

  

  

 دیوایس مدیر ، یکی از دستگا های موجود درسایت ها است که وظایف زیر را به عهده دارد:

  

  در شبکه تلفنیتصدیق کردن) احراز هویت ( دیوایس ها 
 نگهداری و ارائه آخرین اطلاعات آدرس دیوایس ها 

 اعمال تغییرات و ارائه اطلاعات پیشوند شماره های سایت ها 

 .اعمال تغییرات و ارائه اطلاعات مربوط به ترانک هایی که به طور مشترک برای تماس های بیرونی استفاده می شوند 

  سمت سایر دیوایس ها در شبکه تلفنیپاسخگویی به درخواست اطلاعات  بالا  از 

  

 پیکربندی دیوایس  سایت مدیر:

  

 :1مرحله 
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رابفشارید.توجه   Submit آی پی دیوایس  سایت اصلی)سایت مدیر( را وارد کنید و .بروید Basic>Domain name به مسیر

 داشته باشید که آی پی استاتیک دیوایس سایت اصلی نیاز است.

  

 

 

 

 

 :2 مرحله

 را انتخاب کنید. Complexبروید و گزینه  Multi-Siteتب به  
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 :3مرحله 

 رابفشارید. submit را انتخاب کنید و Managing .رول  سایت اصلی را انتخاب کنید.

 

 

  

 

 

 

 

 :4مرحله 

 را انتخاب کنید.  site Add and updateلیست دیوایس هارا بسازید
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 هر سایت  باید منحصر به فرد باشد( IDرا بفشارید.) توجه کنید که  Submitو دکمه اطلاعات سایت هارا وارد کنید.   

 ساختن یا آپدیت كردن طرح شماره گیری: 5مرحله  

  

 را انتخاب کنید. Change prefix of multi-site callingبه صفحه قبل برگردید و گزینه   Multi-siteبافشردن تب 
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 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

  

  

 

  

 توجه:

 .ماره پورت  در تنظیمات لیست دیوایس ها در سایت اصلی استفاده خواهد شدنام دامنه وش

می نویسید ، قبل از شماره داخلی های سایت های دیگر شماره گیری  inter-site calling ای ( که در فیلد prefix ( عددی

 خواهد شد.

 مثال:

شماره داخلی  255نشتن مورد نظر در آن هست و آی دی سایتی که اکست 88به عنوان پیشوند ، رقم  8، رقم  #255-88-8#

 اکستنشن هست.
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 می نویسید، قبل از شماره مقصد گرفته خواهد شد.  Outbound Callingای ( که در فیلد  prefix ( عددی 

 به سمت 88از طریق ترانک سایت با آی دی  2550008282یعنی تماس با   #8-88-2550008282#شماره گیری  

PSTN شد. روت خواهد 

از طریق ترانکی که  سایت  مدیر انتخاب می کند، به  2550008282یعنی تماس با   #2-2550008282#شماره گیری   

 روت خواهد شد. PSTNسمت 

  

 نتیجه:

  # + site id + extension + 1# تماس های داخلی  :  

 # + flexible route  #2 + site id + destination :تماس های خارجی با 

      :   # + fixed rout # + destinationتماس های خارجی با  

 شماره های پیشوند هستند.     2#و  #1 

  

 توجه:

 طرح شماره گیری توسط سایت مدیر تغییر می کند.

 : تنظیمات ترانک های اشتراكی بین سایت ها6مرحله   

  

 Add and گزینه Managing shared trunk recourses به صفحه قبل برگردید و از قسمت   Multi-siteبافشردن تب 

remove the sites which provide trunk sharing .را انتخاب نمایید 
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ترانکهایشان را به اشتراک می گذارند  PSTN، آی پی دیوایس هایی را که برای ارتباط با خطوط  Site nameدر قسمت 

 ،انتخاب کنید.

 منطقه مقصد  را وارد کنید.  کد های Destination در قسمت

 لیست سایت هایی که می توانند از این ترانک اشتراکی استفاده کنند را بنویسید. Site With Permission در قسمت

  

Regular Site)سایت هایی به جز سایت مدیر(: 

  

 کنید. را وارد Regular بروید و آی پی یا دامین سایت  Basic> Domain name به مسیر :1مرحله 
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 :2مرحله 

  

 راانتخاب کنید. Become a regular siteراکلیک کنید و  سپس گزینه   Multi-Siteتب  
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 راانتخاب کنید. Complexسناریوی مورد نظر را انتخاب کنید. 

  

 ید.را بفشار  Submit را انتخاب کنید و دکمه  Regular.رول مورد نظر راانتخاب کنید :3مرحله 

  

  :4مرحله 

 آی پی دیوایس سایت مدیر را وارد کنید 
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 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

  

  

 سبز خواهد شد.  updateاگر تنظیمات با موفقیت انجام شده باشد ، آیکن 

  

 

  

  

  

 

 

 

 

 

 

 

 

  

 6فصل 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 تنظیمات دیوایس
  

 تنظیمات زمان

  

ور در شبکه نداشته باشیم، می توان تایم را به صورت دستی  شما  تایم را از یک تایم سرور در شبکه میگیرد و اگر تایم سر IP-PBX دیوایس

 از طریق رابط وب دیوایس تنظیم کرد.

  

 تنظیمات مربوط به زمان را انجام دهید. System Timeبروید و در قسمت  Basic>Networkبه مسیر 

  

 

 :Administratorتغییر پسورد 

  

 را انتخاب کنید.  Change Password بروید و سپس گزینه  Toolبه تب  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

  

 

 : SIPساخت اكانت 

  

  

-IP در دیوایس SIP به دیوایس متصل شود.بعد از رجیستر شدن اکانت IP-Phone و یا Soft Phone می تواند از طریق SIP یک اکانت

PBX.این اکانت می تواند به سایر اکانت های رجیستر شده در دیوایس متصل شود و ارتباط برقرار کند ، 

 رابفشارید. ADD و سپس دکمه بروید  .Extension>IP extمسیر به 

  

 

 

  

 به صورت دسته جمعی: IPساخت اكانت 

  

 Number of lineرابفشارید و اطلاعات را وارد نمایید.در قسمت  batch add   و سپس دکمه بروید  Extension>IP ext به مسیر

 تا اکانت به صورت اتوماتیک ساخته خواهد شد. 85را وارد کنید،  85عدد تعداد خطوط را وارد کنید.مثلا اگر در این قسمت 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

  

  

 (Voice Mailضبط مکالمات و صندوق صوتی )

  

برای ارسال پیغام های صوتی به ایمیل نیاز  Mail Serverیک فایل سرور برای ضبط مکالمات و صندوق صوتی نیاز هست.به علاوه یک 

 هست.

 فایل سرور و میل سرور:پیکر بندی  آدرس 1مرحله  

  

 اطلاعات مربوط به فایل سرور برای رکورد مکالمات و میل سرور را وارد کنید.  system> Recording/Voice Mail  در تب

  

 

 ها Extension :فعال كردن ضبط مکالمات برای2مرحله  

 ک کنید.آیکن                       کلیبروید  و روی  .Extension> IP ext به مسیر 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 را برای رکورد کردن همه  مکالمات اکستنشن مورد نظر تیک بزنید. Permanent recordingو گزینه 

* در طول مکالمه، مکالمه اش ضبط #راتیک بزنید به کاربر اجازه خواهید داد که با شماره گیری  Recording on demandو اگر گزینه 

 شود.

  

 :3مرحله 

 .را وارد کنید Mail server آی پی system> Recording/Voice Mailدر قسمت 

، ایمیل  کاربر را  برای ارسال فایل صوتی ضبط شده و یا  پیغام صندوق صوتی Emailبروید و در قسمت  .Extension> IP ext به مسیر  

 وارد نمایید.



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

  

 

سرور رکوردینگ نصب می شود، گوش کنند و مدیریت  ( که بررویOM recorderکاربران می توانند فایل های صوتی را طریق نرم افزاری )

 کنند.

 :ترانک آنالوگ  پورت تنظیمات 

  

( ترانک ، پارامترهایی هستند که  به  صدا وابسته هستند.نیاز Busy Tone( و تشخیص اشغال خط)ID detectionتشخیص کالر آی دی)  

 باشد.نیست آنها را تغییر دهید مگر اینکه مشکلی در آنها پیش آمده 

  

 بروید . System>Trunkبرایتغییر پارامترهای مربوط به ترانک به مسیر  

  

 

 تنظیمات پورت تلفن آنالوگ:

 در این قسمت پارامتر هایی  هستند که تماس از طریق تلفن های آنالوگ را بهتر می کنند.نیازی نیست آنها را تغییر دهید مگر اینکه مشکلی

 داشته باشید.hook -flash و  Caller ID در صدا و 

 بروید و پارامتر های مورد نظر را تغییر دهید. System>Extension به مسیر



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

 

  

  

  

 

DTMF: 

 بروید. Advanced>systemبه مسیر DTMFبرای تغییر پارامترهای  

  

 تنظیمات مدیای صدا:

 بروید  Advance>Mediaبرای تنظیم  پارامتر های وابسته به مدیا به مسیر   

  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

  

 توضیح پارامترهای مدیا:

  

Codec   

و کدک های دیگر را می توان وارد  PCMA/20و  G729A/20 ،PCMU/20مقادیر معتبر عبارتند از 

 کرد و با کاما جدا کرد.

Min.RTP port  پایین ترین مقدار ارسال و دریافتRTP  85585-85055  رنج معتبر 

 RTP port یافتبالاترین  مقدار ارسال و در RTP مقدار آن باید بزرگتر یا مساوی.Min.RTP port + *2شماره خط 

 باشد.

TOS/DSCP   های مدیا است. این پارامتر مشخص کننده الویت 

Min.jitter buffer  برای کاهشJitter .در شبکه استفاده می شود 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

Max .jitter buffer  برای کاهش Jitter .در شبکه استفاده می شود 

RTP Drop SID   

RTP Destination 

address 

  

  

 SIP به مربوط پیشرفته تنظیمات

 بروید  Advanced>SIPبه مسیر  

  

 :(Digit Map)تعیین شماره تماس و نقشه ارقام 

 Digit Map  ،طرح تماس هست کهارقام که رول نامیده می شوند،  شامل تعدادی رشته (Dial Plan) مشخص می کند. دیوایس را 

 قشه ارقام که خوب تعریف شده باشد   کمک می کند که سرعت تماس ها بهبود ببخشیده شود.یک ن

 بروید. System>Dialingبه مسیر 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

  

 

 

 

 

 

 

 

  

 

رقم محدود شده .رول های تعریف شده  2225رقم باشد و  طول نقشه ارقام تا  82که هررول می تواند تا  رول   85  نقشه ارقام در دیوایس

 * و غیره را کاور می کند .85طرح تماس کدهای ویژه مانند پیش فرض  

  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 :ویژه كدهای

 بروید و کدهای از پیش تعریف شده را ببینید .می توتنید آنها را تغییر دهید. System>Feature Codeبه مسیر  

  

 

  

  

 

 

 

 جزییات

 :تماس ركورد

ذخیره سازی خارجی ، بفرستد. اطلاعات جزییات تماس شامل شماره  دیوایس قادر است که جزییات تماس  هر داخلی  را به یک سرور 

 تماس گیرنده،شماره پاسخ دهنده تماس، زمان شروع و 

 خاتمه تماس می باشد.

جزییات تماس پس از خاتمه تماس به یک سرور ذخیره سازی فرستاده می شود و می تواند توسط یک نرم افزار  خوانده شود،جستجو 

 حذف شود.شود،ذخیره شود و 

  

 ، آی پی سرور ذخیره سازی را وارد کنید. IP addressبروید و تنظیمات را انجام دهید.در فایل  System>Call Record به مسیر



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

  

 ورودی   تماس كردن بلوكه

 شماره تلفن هایی که نمی خواهیم تماسی از آنها  بیاید را در یک لیست سیاه قرار می دهیم.  

 بروید . System> incoming Call blockingبه مسیر  

  

 

  

 شماره را می توانید به لیست اضافه کنید. 85تا 

اعمال شود  Block Listاگر شماره ای که در این لیست قرار دارد تماس بگیرد توسط سیستم بوق اشغال برایش پخش می شود.برای اینکه 

 فعال شده باشد. Caller IDگزینه تشخیص  باید 

  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 :خروجی های تماس غربال كردن 

 در زمانی که یک تماس خروجی انجام می شود،دیوایس تماس ها را براساس دو جدول غربال میکند، یک لیست سفید و یک لیت سیاه. 

 لیست سفید: 

 باشد.اکستنشن می تواند به شماره )هایی( که در این لیست قرار دارند ، زنگ بزند حتی اگر برای تماس های خروجی محدودیت داشته  

 لیست سیاه: 

 اکستنشن نمی تواند به شماره )هایی( که در این لیست قرار دارند ، زنگ بزند حتی اگر برای تماس های خروجی محدودیت نداشته باشد. 

  

  

 

  

 

 

 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

 

 

 

 

 

 

 

 

 

 

 

 7فصل 

Maintenance 
  

 

 ارتقا فریم ویر:

  

 کنید. Reboot کردن فریم ویر ، دیوایس را upgradeقبل از 

 را بفشارید. Uploadفریم ویر را انتخاب کنید و دکمه  Browse بروید و سپس  با Tool>upgrade به مسیر



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

  

 

  

 رابفشارید. Next کردن فایل فریم ویر، دکمه Upload بعد از

  

 رابفشارید. ok خواهد شد و در پنجره بعد  Reboot بعد از آن سیستم

  

 

  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

  

Reboot :كردن دیوایس 

  

 را بفشارید. OKبروید و دکه  Tool>Restart به مسیر

  

 :تنظیمات های فایل صادر كردن

رابرای دانلود و ذخیره سازی فایل ها در مسیری که به عنوان مقصد تععین  Downloadبروید و دکمه   Tools>Export Data به مسیر

 خواهید کرد، بفشارید.

  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

 و ....نام گذاری خواهند شد . t2.tar.gzو  t1.tar.gzبه طور پیش فرض فایل های دانلود به نام های  

 :تنظیمات های فایل وارد كردن 

 را برای انتخاب فایل تنظیمات بفشارید.  browseبروید و  Tools>Import Dataبه مسیر  

 را بفشارید. Uploadسپس دکمه 

 

 

 

 

 

  

  

  

 

 8فصل 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 ضمیمه
  

 IP PBX OM در دیوایس SIP رجیستر كردن یک اكانت

  

 :1مرحله 

 ( بروید و شماره اکستنشن و پسورد را وارد کنید..Extension>IP extبسازید .)به مسیر   SIPابتدا یک اکانت 

  

 

  

 :2مرحله 

 را کلیک کنید  تا صفحه خصوصیات کاربر را ببینید. ADD ، دکمهSIP،  در قسمت تنظیمات  X-Lite در یک تلفن نرم افزاری مانند 

  



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 

 :3مرحله 

 را بفشارید و فیلدها مانند شکل زیر را پر کنید. Accountتب 

  

  

 

  

  

  

 

 

 

 



 

 

 

  شرکت نیوراک OMسری  IP-PBXراهنمای کارکردن با 

  

  

 http://KavaTelecom.com      كاوا ارتباطات هوشمند

  22پلاک سی و ششم شرقی ، ، ، علامه جنوبی سعادت آبادآدرس : تهران، خیابان 

 22022588 تلفن :

 :SIP Phone)تنظیمات گوشی سیپ ) 

 :1مرحله  

 ( بروید و شماره اکستنشن و پسورد را وارد کنید..Extension>IP extبسازید .)به مسیر   SIPابتدا یک اکانت  

 :2مرحله 

 IP   د کنید تا رابط وب گوشی را ببینید و تنظیمات را مطابق شکل زیر انجام دهید.گوشی را در مرورگرتان وار 

 

 

 

 

 

 

  

 

  

 

 

 

فعال  Advanced>Systemیکسان  را هم از مسیر  DTMFرا فعال کنید و مد  G729کدک  IP Extensionدر هنگام تنظیمات 

 کنید.

 بروید. Basic>Statuesبعد از  انجام تنظیمات،  برای دیدن وضعیت  داخلی ها به مسیر  

  

  

  

  

  

  


